HP Deskjet 1050 All-in-One series
Contents

1 How Do I?...............................................................................................................................3

2 Get to know the HP All-in-One
   Printer parts.....................................................................................................................5
   Control panel features.....................................................................................................6
   Status Lights.....................................................................................................................7

3 Print
   Print documents.............................................................................................................9
   Print photos....................................................................................................................10
   Print envelopes............................................................................................................11
   Tips for print success....................................................................................................11

5 Copy and scan
   Copy documents or photos.........................................................................................23
   Scan to a computer.......................................................................................................24
   Tips for copy and scan success....................................................................................26

6 Work with cartridges
   Check the estimated ink levels....................................................................................27
   Order ink supplies........................................................................................................28
   Replace the cartridges.................................................................................................29
   Use single-cartridge mode.........................................................................................31
   Cartridge warranty information..................................................................................31

7 Solve a problem
   Improve print quality..................................................................................................33
   Clear a paper jam..........................................................................................................35
   Unable to print................................................................................................................37
   HP support....................................................................................................................40

8 Technical information
   Notice............................................................................................................................43
   Specifications................................................................................................................43
   Environmental product stewardship program............................................................45
   Regulatory notices.......................................................................................................48

Index...............................................................................................................................51
1 How Do I?

Learn how to use your HP All-in-One

- Printer parts
- Copy documents or photos
- Load media
- Replace the cartridges
- Clear a paper jam
2 Get to know the HP All-in-One

- Printer parts
- Control panel features
- Status Lights

Printer parts

1. Input tray
2. Paper-width guide for the input tray
3. Control panel
4. Cartridge door
5. Output tray
6. Output tray extender (also referred to as the tray extender)
7. Cartridges
Control panel features

1 **Power**: Turns the product on or off. When the product is off, a minimal amount of power is still used. To completely remove power, turn off the product, then unplug the power cord.

2 **Cancel**: Stops the current operation.

3 **Start Copy Black**: Starts a black-and-white copy job. Increase the number of copies (up to 10) by pressing the button multiple times. Acts as a resume button after resolving print problems.

4 **Start Copy Color**: Starts a color copy job. Increase the number of copies (up to 10) by pressing the button multiple times. Acts as a resume button after resolving print problems.

5 **Attention light**: Indicates that there is a paper jam, the printer is out of paper, or some event that requires your attention.

6 **Cartridge light**: Indicates low ink or a print cartridge problem.
When the product is turned on, the on button light will be lit. When the product is processing a job, the on light will be blinking. Additional blinking lights signal errors that you can resolve. See below to learn about blinking lights and what to do.

<table>
<thead>
<tr>
<th>Behavior</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power light is blinking and attention light is on (not blinking)</td>
<td>The output tray is closed, there is no paper, or there is a paper jam. Replace the cartridges, correctly Load media, or Clear a paper jam. Press Start Copy Black or Start Copy Color to resume.</td>
</tr>
<tr>
<td></td>
<td><strong>Behavior</strong></td>
</tr>
<tr>
<td>Power light is blinking, both cartridge lights are blinking, and the attention light is on (not blinking)</td>
<td>The cartridge door is open, or the carriage is obstructed. If the cartridge door is open, close it. See Prepare the trays for more information. If the carriage is obstructed, open cartridge door and move the carriage to the right to clear the obstruction. Press Start Copy Black or Start Copy color to resume. See Clear the print carriage for more information.</td>
</tr>
<tr>
<td>One cartridge light is on (not blinking)</td>
<td>An “on” cartridge light indicates that the corresponding cartridge still has the tape on, is not installed, or is low on ink. Remove the pink tape if it is still on the cartridge, insert a cartridge if one is missing, or replace the cartridge when print quality is no longer acceptable. For more information, see Replace the cartridges.</td>
</tr>
<tr>
<td>Both cartridge lights are on (not blinking)</td>
<td>Both cartridges are low on ink. Replace both cartridges when print quality is no longer acceptable.</td>
</tr>
<tr>
<td>One cartridge light is blinking</td>
<td>A “blinking” cartridge light indicates that the corresponding cartridge is not installed correctly or is incompatible. If the cartridge is not installed correctly, reinsert the cartridge. If the cartridge is incompatible, replace it with a compatible cartridge.</td>
</tr>
<tr>
<td>Both cartridge lights are blinking</td>
<td>Both cartridges may still have the tape on, are missing, or are defective. Remove the pink tape from both cartridges if it is still on the cartridges, install the missing cartridges or replace the defective cartridges. See</td>
</tr>
<tr>
<td>Behavior</td>
<td>Solution</td>
</tr>
<tr>
<td>----------</td>
<td>----------</td>
</tr>
<tr>
<td>Identify a defective cartridge to identify if only one cartridge is a defective.</td>
<td></td>
</tr>
<tr>
<td>Both cartridge lights and attention light are blinking</td>
<td>The cartridge carriage inside the printer has stalled. Open cartridge door and make sure the carriage is not obstructed, close door, and then press the <strong>Start Copy Black</strong> or <strong>Start Copy Color</strong> button to resume.</td>
</tr>
</tbody>
</table>
| Power light, both cartridge lights, and attention light are blinking | The printer is in an error state. To exit the error state, reset the product.  
1. Turn off the product.  
2. Unplug the power cord.  
3. Wait a minute, then plug the power cord back in.  
4. Turn on the product.  
If the problem persists, contact **Replace the cartridges.** |
3 Print

Choose a print job to continue.

Print documents

Print photos

Print envelopes

Print documents

To print from a software application
1. Make sure the output tray is open.
2. Make sure you have paper loaded in the input tray.
3. From your software application, click the Print button.
4. Make sure the product is the selected printer.
5. Click the button that opens the Properties dialog box. Depending on your software application, this button might be called Properties, Options, Printer Setup, Printer, or Preferences.
6. Select the appropriate options.
   • On Layout tab select Portrait or Landscape orientation.
   • On Paper/Quality tab select the appropriate paper type and print quality from the Media drop-down list.
   • Click Advanced to select the appropriate paper size from the Paper/Output list.
7. Click OK to close the Properties dialog box.
8. Click Print or OK to begin printing.
NOTE: You can print your document on both sides of the paper, instead of just one side. Click on the **Advanced** button on the **Paper/Quality** or **Layout** tab. From the **Pages to Print** drop-down menu select **Print Odd Pages Only**. Click **OK** to print. After the odd numbered pages of the document have been printed, remove the document from the output tray. Reload the paper in the input tray with the blank side facing up. Return to the **Pages to Print** drop-down menu and then select **Print Even Pages Only**. Click **OK** to print.

---

### Print photos

**To print a photo on photo paper**

1. Make sure the output tray is open.
2. Remove all paper from the input tray, and then load the photo paper print side up.

   **NOTE:** If the photo paper you are using has perforated tabs, load photo paper so that tabs are on top.

3. On the **File** menu in your software application, click **Print**.
4. Make sure the product is the selected printer.
5. Click the button that opens the **Properties** dialog box. Depending on your software application, this button might be called **Properties**, **Options**, **Printer Setup**, **Printer**, or **Preferences**.
6. Click the **Paper/Quality** tab.
7. Select the appropriate options.
   - On **Layout** tab select **Portrait** or **Landscape** orientation.
   - On **Paper/Quality** tab select the appropriate paper type and print quality from the **Media** drop-down list.
   - Click **Advanced** to select the appropriate paper size from the **Paper/Output** list.

   **NOTE:** For maximum dpi resolution, go to the **Paper/Quality** tab and select **Photo Paper, Best Quality** from the **Media** drop-down list. Make sure you are printing in color. Then go to the **Advanced** tab and select **Yes** from the **Print in Max DPI** drop-down list. For more information, see [Print using the maximum dpi](#).

8. Click **OK** to return to the **Properties** dialog box.
9. Click **OK**, and then click **Print** or **OK** in the **Print** dialog box.
NOTE: Do not leave unused photo paper in the input tray. The paper might start to curl, which could reduce the quality of your printout. Photo paper should be flat before printing.

Print envelopes

You can load one or more envelopes into the input tray of the HP All-in-One. Do not use shiny or embossed envelopes or envelopes that have clasps or windows.

NOTE: For specific details on how to format text for printing on envelopes, consult the help files in your word processing software. For best results, consider using a label for the return address on envelopes.

To print envelopes

1. Make sure the output tray is open.
2. Slide the paper guide all the way to the left.
3. Place the envelopes in the right side of the tray. The side to be printed on should face up. The flap should be on the left side.
4. Push the envelopes into the printer until they stop.
5. Slide the paper guide firmly against the edge of the envelopes.

6. Click the button that opens the Properties dialog box. Depending on your software application, this button might be called Properties, Options, Printer Setup, Printer, or Preferences.
7. Select the appropriate options.
   • On Paper/Quality tab select a Plain paper type.
   • Click the Advanced button, and select the appropriate envelope size from the Paper Size drop down menu.
8. Click OK, and then click Print or OK in the Print dialog box.

Tips for print success

To successfully print, the HP cartridges should be functioning properly with sufficient ink, the paper should be loaded correctly, and the product should have the appropriate settings.
Cartridge tips

- Use genuine HP ink cartridges.
- Install both the black and tri-color cartridges correctly. For more information, see Replace the cartridges.
- Check the estimated ink levels in the cartridges to make sure there is sufficient ink. For more information, see Check the estimated ink levels.
- For more information, see Improve print quality.

Paper loading tips

- Load a stack of paper (not just one page). All of the paper in the stack should be the same size and type to avoid a paper jam.
- Load paper with side to be printed on facing up.
- Ensure that paper loaded in the input tray lays flat and the edges are not bent or torn.
- Adjust the paper-width guide in the input tray to fit snugly against all paper. Make sure the paper-width guide does not bend the paper in the input tray.
- For more information, see Load media.

Printer settings tips

- On the Paper/Quality tab of the print driver, select the appropriate paper type and quality from the Media drop down menu.
- Click the Advanced button, and select the appropriate Paper Size from the Paper/Output drop-down menu.
- Click the HP All-in-One desktop icon to open the Printer Software.

**NOTE:** You can also access the Printer Software by clicking Start > Programs > HP > HP Deskjet 1050 J410 > HP Deskjet 1050 J410

Notes

- Genuine HP ink cartridges are designed and tested with HP printers and papers to help you easily produce great results, time after time.

**NOTE:** HP cannot guarantee the quality or reliability of non-HP supplies. Product service or repairs required as a result of using a non-HP supply will not be covered under warranty.

If you believe you purchased genuine HP ink cartridges, go to: www.hp.com/go/anticounterfeit

- Ink level warnings and indicators provide estimates for planning purposes only.

**NOTE:** When you receive a low-ink warning message, consider having a replacement cartridge available to avoid possible printing delays. You do not need to replace the cartridges until print quality becomes unacceptable.

- Software settings selected in the print driver only apply to printing, they do not apply to copying or scanning.
• You can print your document on both sides of the paper, instead of just one side.

**NOTE:** Click the **Advanced** button on the **Paper/Quality** or **Layout** tab. From the **Pages to Print** drop-down menu select **Print Odd Pages Only**. Click **OK** to print. After the odd numbered pages of the document have been printed, remove the document from the output tray. Reload the paper in the input tray with the blank side facing up. Return to the **Pages to Print** drop-down menu and then select **Print Even Pages Only**. Click **OK** to print.

• Print using black ink only

**NOTE:** If you want to print a black and white document using black ink only, click the **Advanced** button. From the **Print in Grayscale** drop-down menu select **Black Ink Only**, then click the **OK** button. If you see **Black and White** as an option on the **Paper/Quality** tab or the **Layout** tab, select it.

[Click here to go online for more information.]

### Print using the maximum dpi

Use maximum dots per inch (dpi) mode to print high-quality, sharp images on photo paper.

See technical specifications for the print resolution of the maximum dpi mode.

Printing in maximum dpi takes longer than printing with other settings and requires a large amount of disk space.

**To print in Maximum dpi mode**

1. Make sure you have photo paper loaded in the input tray.
2. On the **File** menu in your software application, click **Print**.
3. Make sure the product is the selected printer.
4. Click the button that opens the **Properties** dialog box. Depending on your software application, this button might be called **Properties**, **Options**, **Printer Setup**, **Printer**, or **Preferences**.
5. Click the **Paper/Quality** tab.
6. In the **Media** drop-down list, click **Photo Paper, Best Quality**.

**NOTE:** **Photo Paper, Best Quality** must be selected from the **Media** drop-down list on the **Paper/Quality** tab to enable printing in maximum DPI.

7. Click the **Advanced** button.
8. In the **Printer Features** area, select **Yes** from the **Print in Max DPI** drop-down list.
9. Select **Paper Size** from **Paper/Output** drop-down menu.
10. Click **OK** to close the advanced options.
11. Confirm **Orientation** on **Layout** tab, then click **OK** to print.
4 Paper basics

You can load many different types and sizes of paper in the HP All-in-One, including letter or A4 paper, photo paper, transparencies, and envelopes.

This section contains the following topics:

Load media

Recommended papers for printing

If you want the best print quality, HP recommends using HP papers that are specifically designed for the type of project you are printing.

Depending on your country/region, some of these papers might not be available.

ColorLok
HP recommends plain papers with the ColorLok logo for printing and copying of everyday documents. All papers with the ColorLok logo are independently tested to meet high standards of reliability and print quality, and produce documents with crisp, vivid color, bolder blacks, and dry faster than ordinary plain papers. Look for papers with the ColorLok logo in a variety of weights and sizes from major paper manufacturers.

HP Advanced Photo Paper
This thick photo paper features an instant-dry finish for easy handling without smudging. It resists water, smears, fingerprints, and humidity. Your prints have a look and feel comparable to a store-processed photo. It is available in several sizes, including A4, 8.5 x 11 inch, 10 x 15 cm (4 x 6 inch) (with or without tabs), 13 x 18 cm (5 x 7 inch), and two finishes - glossy or soft gloss (satin matte). It is acid-free for longer lasting documents.

HP Everyday Photo Paper
Print colorful, everyday snapshots at a low cost, using paper designed for casual photo printing. This affordable, photo paper dries quickly for easy handling. Get sharp, crisp images when you use this paper with any inkjet printer. It is available in semi-gloss finish in several sizes, including A4, 8.5 x 11 inch, and 10 x 15 cm (4 x 6 inch) (with or without tabs). For longer-lasting photos, it is acid-free.
**HP Brochure Paper or HP Superior Inkjet Paper**
These papers are glossy-coated or matte-coated on both sides for two-sided use. They are the perfect choice for near-photographic reproductions and business graphics for report covers, special presentations, brochures, mailers, and calendars.

**HP Premium Presentation Paper or HP Professional Paper**
These papers are heavy two-sided matte papers perfect for presentation, proposals, reports, and newsletters. They are heavyweight for an impressive look and feel.

**HP Bright White Inkjet Paper**
HP Bright White Inkjet Paper delivers high-contrast colors and sharp text. It is opaque enough for two-sided color usage with no show-through, which makes it ideal for newsletters, reports, and flyers. It features ColorLok Technology for less smearing, bolder blacks, and vivid colors.

**HP Printing Paper**
HP Printing Paper is a high-quality multifunction paper. It produces documents that look and feel more substantial than documents printed on standard multipurpose or copy paper. It features ColorLok Technology for less smearing, bolder blacks, and vivid colors. It is acid-free for longer lasting documents.

**HP Office Paper**
HP Office Paper is a high-quality multifunction paper. It is suitable for copies, drafts, memos, and other everyday documents. It features ColorLok Technology for less smearing, bolder blacks, and vivid colors. It is acid-free for longer lasting documents.

**HP Iron-On Transfers**
HP Iron-on Transfers (for color fabrics or for light or white fabrics) are the ideal solution for creating custom T-shirts from your digital photos.

**HP Premium Inkjet Transparency Film**
HP Premium Inkjet Transparency Film make your color presentations vivid and even more impressive. This film is easy to use and handle and dries quickly without smudging.

**HP Photo Value Pack**
HP Photo Value Packs conveniently package original HP cartridges and HP Advanced Photo Paper to save you time and take the guesswork out of printing affordable professional photos with your HP All-in-One. Original HP inks and HP Advanced Photo Paper have been designed to work together so your photos are long lasting and vivid, print after print. Great for printing out an entire vacation’s worth of photos or multiple prints to share.

**NOTE:** At this time, some portions of the HP Web site are available in English only.

To order HP papers and other supplies, go to [www.hp.com/buy/supplies](http://www.hp.com/buy/supplies). If prompted, choose your country/region, follow the prompts to select your product, and then click one of the shopping links on the page.
Load media

▲ Select a paper size to continue.

Load full-size paper
a. Raise the input tray
   ❑ Raise the input tray.

b. Lower the output tray
   ❑ Lower the output tray and pull out the tray extender.
c. Slide paper-width guide to the left
   - Slide paper-width guide to the left.

   ![Image of printer with paper-width guide moved to the left]

   ![Image of printer with paper inserted]

   d. Load paper.
   - Insert stack of paper into input tray with short edge forward and print side up.

   ![Image of printer with paper inserted]

   - Slide stack of paper down until it stops.
   - Slide paper-width guide to the right until it stops at edge of paper.
Load small-size paper

a. Raise the input tray
   - Raise the input tray.

b. Lower the output tray
   - Lower the output tray and pull out the tray extender.
c. Slide paper-width guide to the left.
   - Slide paper-width guide to the left.

   ![Image of printer with paper-width guide]


d. Load paper.
   - Insert stack of photo paper with short edge down and print side up.
   - Slide stack of paper forward until it stops.

   **NOTE:** If the photo paper you are using has perforated tabs, load photo paper so that tabs are on top.

   - Slide paper-width guide to the right until it stops at edge of paper.

   ![Image of printer with paper-width guide]
Load envelopes

a. Raise the input tray
   - Raise the input tray.

b. Lower the output tray
   - Lower the output tray and pull out the tray extender.

c. Slide paper-width guide to the left.
   - Slide paper-width guide to the left.
- Remove all paper from the main input tray.
- **d.** Load envelopes.
  - Insert one or more envelopes into far-right side of the input tray. The side to be printed on should face up. The flap should be on the left side and facing down.
  - Slide stack of envelopes down until it stops.
  - Slide paper-width guide to the right against stack of envelopes until it stops.
5 Copy and scan

• Copy documents or photos
• Scan to a computer
• Tips for copy and scan success

Copy documents or photos

NOTE: All documents are copied in normal quality print mode. You cannot change the print mode quality when copying.

▲ Do one of the following:

1-sided original to 1-sided copy

a. Load paper.
   □ Load either small photo paper or full-size paper in the input tray.

b. Load original.
   □ Lift lid on product.
Load original print side down on right front corner of glass.

- Close lid.
- Start copy.
  - Press either Start Copy Black or Start Copy Color. Increase the number of copies by pressing the button multiple times.

**Scan to a computer**

*NOTE:* To scan to a computer, the HP All-in-One and computer must be connected and turned on.
To scan to a computer:

**Single page scan**

a. Load paper.
   - Load either small photo paper or full-size paper in the input tray.

b. Load original.
   - Lift lid on product.
   - Load original print side down on right front corner of glass.
❑ Close lid.

![Copy and scan setup image]

c. Start scan.

❑ Start the **Scan** job using the Printer Software. Click the HP All-in-One desktop icon to open the Printer Software.

**NOTE:** You can also access the Printer Software by clicking **Start > Programs > HP > HP Deskjet 1050 J410 > HP Deskjet 1050 J410**

❑ Select **Scanner Actions**. You will see scan options that you can select onscreen.

**Tips for copy and scan success**

- Load your original print side down on the right front corner of the glass.

  ![Copy and scan tips image]

- Clean the scanner glass and make sure that there are no foreign materials adhering to it.

  ![Contact us for help]

  **Click here to go online for more information.**
6 Work with cartridges

- Check the estimated ink levels
- Order ink supplies
- Replace the cartridges
- Use single-cartridge mode
- Cartridge warranty information

Check the estimated ink levels

You can easily check the ink supply level to determine how soon you might need to replace a cartridge. The ink supply level shows an estimate of the amount of ink remaining in the cartridges.

To check the ink levels from the Printer Software

1. Click the HP All-in-One desktop icon to open the Printer Software.

   ![NOTE: You can also access the Printer Software by clicking Start > Programs > HP > HP Deskjet 1050 J410 > HP Deskjet 1050 J410](image)

2. In the Printer Software, click Printer Actions and then click Maintenance Tasks to access the Printer Toolbox.

3. Click the Estimated Ink Level tab.

   ![NOTE: If you have installed a refilled or remanufactured cartridge, or a cartridge that has been used in another printer, the ink level indicator might be inaccurate or unavailable.](image)

   ![NOTE: Ink level warnings and indicators provide estimates for planning purposes only. When you receive a low-ink warning message, consider having a replacement cartridge available to avoid possible printing delays. You do not have to replace the cartridges until the print quality is unacceptable.](image)

   ![NOTE: Ink from the cartridges is used in the printing process in a number of different ways, including in the initialization process, which prepares the product and cartridges for printing, and in printhead servicing, which keeps print nozzles clear and ink flowing smoothly. In addition, some residual ink is left in the cartridge after it is used. For more information, see [www.hp.com/go/inkusage](http://www.hp.com/go/inkusage).](image)
Order ink supplies

Before ordering cartridges, locate the correct cartridge number.

Locate the cartridge number on the printer
△ The cartridge number is located inside the cartridge door.

Locate the cartridge number in the Printer Software
1. Click the HP All-in-One desktop icon to open the Printer Software.
   
   **NOTE:** You can also access the Printer Software by clicking Start > Programs > HP > HP Deskjet 1050 J410 > HP Deskjet 1050 J410

2. In the Printer Software, click Shop For Supplies Online. The correct cartridge number will be automatically displayed when you use this link.

To order genuine HP supplies for the HP All-in-One, go to www.hp.com/buy/supplies. If prompted, choose your country/region, follow the prompts to select your product, and then click one of the shopping links on the page.

   **NOTE:** Ordering cartridges online is not supported in all countries/regions. If it is not available in your country/region, you may still view supplies information and print a list for reference when shopping at a local HP reseller.

Related topics
Choose the right cartridges

Choose the right cartridges

HP recommends that you use original HP cartridges. Original HP cartridges are designed and tested with HP printers to help you easily produce great results, time after time.

Related topics
Order ink supplies
Replace the cartridges

To replace the cartridges
1. Check power.
2. Load paper.
3. Remove cartridge.
   a. Open cartridge door.

Wait for print carriage to move to center of the product.

b. Press down to release cartridge, then remove it from slot.
4. Insert new cartridge.
   a. Remove cartridge from packaging.

   ![Image of a cartridge being removed from packaging]

   b. Remove plastic tape using pink pull tab.

   ![Image of a cartridge with plastic tape being removed]

   c. Slide cartridge into slot until it clicks into place.
d. Close cartridge door.

5. Align cartridges.

Related topics
• Choose the right cartridges
• Order ink supplies

Use single-cartridge mode
Use the single-cartridge mode to operate the HP All-in-One with only one print cartridge. The single-cartridge mode is initiated when a print cartridge is removed from the print cartridge carriage. During single-cartridge mode, the product can only print jobs from the computer.

NOTE: When the HP All-in-One operates in single-cartridge mode, a message is displayed on screen. If the message is displayed and two print cartridges are installed in the product, verify that the protective piece of plastic tape has been removed from each print cartridge. When plastic tape covers the print cartridge contacts, the product cannot detect that the print cartridge is installed.

Exit single-cartridge mode
Install two print cartridges in the HP All-in-One to exit single-cartridge mode.

Related topics
Replace the cartridges

Cartridge warranty information
The HP cartridge warranty is applicable when the product is used in its designated HP printing device. This warranty does not cover HP ink products that have been refilled, remanufactured, refurbished, misused, or tampered with.
During the warranty period the product is covered as long as the HP ink is not depleted and the end of warranty date has not been reached. The end of warranty date, in YYYY/MM/DD format, may be found on the product as indicated:

For a copy of the HP Limited Warranty Statement, see the printed documentation that came with the product.
7 Solve a problem

This section contains the following topics:

- Improve print quality
- Clear a paper jam
- Unable to print
- HP support

Click here to go online for more information.

Improve print quality

1. Make sure you are using genuine HP cartridges.

2. Check the Printer Software settings to make sure you have selected the appropriate paper type and print quality from the Media drop-down list.

3. Check the estimated ink levels to determine if the cartridges are low on ink. For more information, see Check the estimated ink levels. If the print cartridges are low on ink consider replacing them.

4. Align the printer cartridges

To align the cartridges from the Printer Software

NOTE: Aligning the cartridges ensures high-quality output. The HP All-in-One prompts you to align the cartridges every time you install a new cartridge. If you remove and reinstall the same print cartridge, the HP All-in-One will not prompt you to align the print cartridges. The HP All-in-One remembers the alignment values for that print cartridge, so you do not need to realign the print cartridges.

a. Load letter or A4 unused plain white paper into the input tray.

b. In the Printer Software, click Printer Actions and then click Maintenance Tasks to access the Printer Toolbox.

c. The Printer Toolbox appears.

d. Click the Device Services tab.

e. Click Align Ink Cartridges tab. The product prints an alignment sheet.

f. Load the cartridge alignment sheet print side down on the right front corner of the glass.

g. Press the Start Copy Black button. The product aligns the cartridges. Recycle or discard the cartridge alignment sheet.

5. Print a diagnostics page if the cartridges are not low on ink.

To print a diagnostics page

a. Load letter or A4 unused plain white paper into the input tray.

b. In the Printer Software, click Printer Actions and then click Maintenance Tasks to access the Printer Toolbox.

c. Click Print Diagnostic Information to print a diagnostics page. Review the blue, magenta, yellow, and black boxes on the diagnostics page. If you are seeing
streaks in the color and black boxes, or no ink in portions of the boxes, then automatically clean the cartridges

6. Clean the print cartridges automatically, if the diagnostic page shows streaks or missing portions of the color and black boxes.

To clean the cartridges automatically
   a. Load letter or A4 unused plain white paper into the input tray.
   b. In the Printer Software, click Printer Actions and then click Maintenance Tasks to access the Printer Toolbox.
   c. Click Clean Ink Cartridges. Follow the onscreen instructions.

If the above solutions do not resolve the problem, click here for more online troubleshooting.
Clear a paper jam

Clear a paper jam.

To clear a paper jam
1. Press the cancel button to try to clear the jam automatically. If this does not work, the paper jam will need to be cleared manually.
2. Locate the paper jam

Input tray
If the paper jam is located near the back input tray, pull the paper gently out of the input tray.

Output tray
• If the paper jam is located near the front output tray, pull the paper gently out of the output tray.
• You may need to open the carriage door and slide the print carriage to the right to access the paper jam.
**Inside of printer**

- If the paper jam is located inside the printer, open the cleanout door located on the bottom of the printer. Press tabs on both sides of the cleanout door.

- Remove jammed paper.

- Close the cleanout door. Gently push the door towards the printer until both latches snap into place.

3. Press the Start Copy Black or Start Copy Color button on the control panel to continue the current job.

If the above solutions do not resolve the problem, [click here for more online troubleshooting](#).

**Prevent paper jams**

- Do not overfill the input tray.
- Remove printed papers from the output tray frequently.
- Ensure that paper loaded in the input tray lays flat and the edges are not bent or torn.
- Do not combine different paper types and paper sizes in the input tray; the entire stack of paper in the input tray must be the same size and type.
- Adjust the paper-width guide in the input tray to fit snugly against all paper. Make sure the paper-width guide does not bend the paper in the input tray.
- Do not force paper too far forward in the input tray.
If the above solutions do not resolve the problem, click here for more online troubleshooting.

Unable to print

Make sure that the printer is turned on and that there is paper in the tray. If you are still unable to print, try the following in order:

1. Check for error messages and resolve.
2. Disconnect and reconnect the USB cable.
3. Verify that the product is not paused or offline.

To verify that the product is not paused or offline

**NOTE:** HP provides a Printer Diagnostic Utility that can automatically fix this issue.

Click here to go online for more information, Otherwise, follow the steps below.

a. Depending upon your operating system, do one of the following:
   - **Windows 7**: From the Windows Start menu, click Devices and Printers.
   - **Windows Vista**: From the Windows Start menu, click Control Panel, and then click Printers.
   - **Windows XP**: From the Windows Start menu, click Control Panel, and then click Printers and Faxes.

b. Double-click the icon for your product to open the print queue.

c. On the Printer menu, make sure there are no check marks next to Pause Printing or Use Printer Offline.

d. If you made any changes, try to print again.

4. Verify that the product is set as the default printer.

To verify that the product is set as the default printer

**NOTE:** HP provides a Printer Diagnostic Utility that can automatically fix this issue.

Click here to go online for more information, Otherwise, follow the steps below.

a. Depending upon your operating system, do one of the following:
   - **Windows 7**: From the Windows Start menu, click Devices and Printers.
   - **Windows Vista**: From the Windows Start menu, click Control Panel, and then click Printers.
   - **Windows XP**: From the Windows Start menu, click Control Panel, and then click Printers and Faxes.

b. Make sure the correct product is set as the default printer.

The default printer has a check mark in a black or green circle next to it.
c. If the wrong product is set as the default printer, right-click the correct product and select **Set as Default Printer**.

d. Try using your product again.

5. Restart the print spooler.

To restart the print spooler

**NOTE:** HP provides a Printer Diagnostic Utility that can automatically fix this issue. Click here to go online for more information. Otherwise, follow the steps below.

a. Depending upon your operating system, do one of the following:

**Windows 7**
- From the Windows **Start** menu, click **Control Panel, System and Security**, and then **Administrative Tools**.
- Double-click **Services**.
- Right-click the **Print Spooler**, and then click **Properties**.
- On the **General** tab, next to **Startup type**, make sure that **Automatic** is selected.
- If the service is not already running, under **Service status**, click **Start**, and then click **OK**.

**Windows Vista**
- From the Windows **Start** menu, click **Control Panel, System and Maintenance, Administrative Tools**.
- Double-click **Services**.
- Right-click the **Print Spooler service**, and then click **Properties**.
- On the **General** tab, next to **Startup type**, make sure that **Automatic** is selected.
- If the service is not already running, under **Service status**, click **Start**, and then click **OK**.

**Windows XP**
- From the Windows **Start** menu, right click **My Computer**.
- Click **Manage**, and then click **Services and Applications**.
- Double-click **Services**, and then select **Print Spooler**.
- Right-click **Print Spooler**, and click **Restart** to restart the service.

b. Make sure the correct product is set as the default printer. The default printer has a check mark in a black or green circle next to it.

c. If the wrong product is set as the default printer, right-click the correct product and select **Set as Default Printer**.

d. Try using your product again.
6. Restart the computer.
7. Clear the print queue

To clear the print queue

**NOTE:** HP provides a Printer Diagnostic Utility that can automatically fix this issue.

[Click here to go online for more information](#) Otherwise, follow the steps below.

a. Depending upon your operating system, do one of the following:
   - Windows 7: From the Windows Start menu, click Devices and Printers.
   - Windows Vista: From the Windows Start menu, click Control Panel, and then click Printers.
   - Windows XP: From the Windows Start menu, click Control Panel, and then click Printers and Faxes.

b. Double-click the icon for your product to open the print queue.

c. On the Printer menu, click Cancel all documents or Purge Print Document, and then click Yes to confirm.

d. If there are still documents in the queue, restart the computer and try printing again after the computer has restarted.

e. Check the print queue again to make sure it is clear, and then try to print again. If the print queue is not clear, or if it is clear but jobs are still failing to print, proceed to the next solution.

If the above solutions do not resolve the problem, [click here for more online troubleshooting](#).

Clear the print carriage

Remove any objects, such as paper, that are blocking the print carriage.

**NOTE:** Do not use any tools or other devices to remove jammed paper. Always use caution when removing jammed paper from inside the product.

[Click here to go online for more information](#).

Identify a defective cartridge

If both the tri-color and black cartridge lights are blinking, and the power light is on, both cartridges may still have tape on, or are missing. First make sure that the pink tape has been removed from both cartridges, and that both cartridges are installed. If both cartridge
lights are still blinking, then one or both cartridges may be defective. To determine if one cartridge is defective do the following:

1. Remove black cartridge.
2. Close cartridge door.
3. If the On light blinks, the tri-color cartridge should be replaced. If the On light does not blink, replace the black cartridge.

Prepare the trays

Open output tray

▲ Output tray must be open to begin printing.

Close cartridge door

▲ Cartridge door must be closed to begin printing.

Resolve copy and scan issues

Click here to go online for more information.

HP support

- Register the product
- Support process
Register the product

By taking just a few quick minutes to register, you can enjoy quicker service, more efficient support, and product support alerts. If you did not register your printer while installing the software, you can register now at http://www.register.hp.com.

Support process

If you have a problem, follow these steps:
1. Check the documentation that came with the product.
2. Visit the HP online support Web site at www.hp.com/support. HP online support is available to all HP customers. It is the fastest source for up-to-date product information and expert assistance and includes the following features:
   • Fast access to qualified online support specialists
   • Software and driver updates for the product
   • Valuable product and troubleshooting information for common problems
   • Proactive product updates, support alerts, and HP newsgrams that are available when you register the product
3. Call HP support. Support options and availability vary by product, country/region, and language.

HP support by phone

Phone support options and availability vary by product, country/region, and language. This section contains the following topics:

• Phone support period
• Placing a call
• Support phone numbers
• After the phone support period

Phone support period

One year of phone support is available in North America, Asia Pacific, and Latin America (including Mexico). To determine the duration of phone support in Europe, the Middle East, and Africa, go to www.hp.com/support. Standard phone company charges apply.
Placing a call

Call HP support while you are in front of the computer and the product. Be prepared to provide the following information:

- Product name (HP Deskjet 1050 All-in-One series)
- Model number (located inside the cartridge door)
- Serial number (located on the back or bottom of the product)
- Messages that appear when the situation occurs
- Answers to these questions:
  - Has this situation happened before?
  - Can you re-create it?
  - Did you add any new hardware or software to your computer at about the time that this situation began?
  - Did anything else occur prior to this situation (such as a thunderstorm, product was moved, etc.)?

Support phone numbers

For the most current HP list of telephone support numbers and call costs information, see www.hp.com/support.

After the phone support period

After the phone support period, help is available from HP at an additional cost. Help may also be available at the HP online support Web site: www.hp.com/support. Contact your HP dealer or call the support phone number for your country/region to learn more about support options.

Additional warranty options

Extended service plans are available for the HP All-in-One at additional costs. Go to www.hp.com/support, select your country/region and language, then explore the services and warranty area for information about the extended service plans.
8 Technical information

The technical specifications and international regulatory information for the HP All-in-One are provided in this section.
For additional specifications, see the printed documentation that came with the HP All-in-One.
This section contains the following topics:
- Notice
- Specifications
- Environmental product stewardship program
- Regulatory notices

Notice

Hewlett-Packard Company notices

The information contained in this document is subject to change without notice.
All rights reserved. Reproduction, adaptation, or translation of this material is prohibited without prior written permission of Hewlett-Packard, except as allowed under copyright laws. The only warranties for HP products and services are set forth in the express warranty statements accompanying such products and services. Nothing herein should be construed as constituting an additional warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.
© 2009 Hewlett-Packard Development Company, L.P.
Microsoft, Windows, Windows XP, and Windows Vista are U.S. registered trademarks of Microsoft Corporation.
Windows 7 is either a registered trademark or trademark of Microsoft Corporation in the United States and/or other countries.
Intel and Pentium are trademarks or registered trademarks of Intel Corporation or its subsidiaries in the United States and other countries.

Specifications

Technical specifications for the HP All-in-One are provided in this section. For complete product specifications, see the Product Data Sheet at www.hp.com/support.

System requirements

For information about future operating system releases and support, visit the HP online support Web site at www.hp.com/support.

Environmental specifications

- Recommended operating temperature range: 15 °C to 32 °C (59 °F to 90 °F)
- Allowable operating temperature range: 5 °C to 40 °C (41 °F to 104 °F)
- Humidity: 15% to 80% RH non-condensing; 28 °C maximum dewpoint
- Non-operating (Storage) temperature range: –40 °C to 60 °C (–40 °F to 140 °F)
- In the presence of high electromagnetic fields, it is possible the output from the HP All-in-One may be slightly distorted
- HP recommends using a USB cable less than or equal to 3 m (10 feet) in length to minimize injected noise due to potential high electromagnetic fields

Input tray capacity

Plain paper sheets (80 g/m2 [20lb]): Up to 50
Envelopes: Up to 5
Index cards: Up to 20
Photo paper sheets: Up to 20

Output tray capacity

Plain paper sheets (80 g/m2 [20lb]): Up to 30
Envelopes: Up to 5
Index cards: Up to 10
Photo paper sheets: Up to 10

**Paper size**
For a complete list of supported media sizes, see the printer software.

**Paper weights**
Plain Paper: 64 to 90 g/m² (16 to 24 lb)
Envelopes: 75 to 90 g/m² (20 to 24 lb)
Cards: Up to 200 g/m² (110-lb index maximum)
Photo Paper: Up to 280 g/m² (75 lb)

**Print specifications**
- Print speeds vary according to the complexity of the document
- Method: drop-on-demand thermal inkjet
- Language: PCL3 GUI

**Copy specifications**
- Digital image processing
- Copy speeds vary according to the complexity of the document and model

**Scan specifications**
- Resolution: up to 1200 x 1200 ppi optical
  - For more information about ppi resolution, see the scanner software.
- Color: 24-bit color, 8-bit grayscale (256 levels of gray)
- Maximum scan size from glass: 21.6 x 29.7 cm (8.5 x 11.7 inches)

**Print resolution**

**Draft mode**
- Color Input/Black Render: 300x300dpi
- Output (Black/Color): Automatic

**Normal mode**
- Color Input/Black Render: 600x300dpi
- Output (Black/Color): Automatic

**Plain-Best mode**
- Color Input/Black Render: 600x600dpi
- Output: 600x1200dpi (Black), Automatic (Color)

**Photo-Best mode**
- Color Input/Black Render: 600x600dpi
- Output (Black/Color): Automatic

**Max DPI mode**
- Color Input/Black Render: 1200x1200dpi
- Output: Automatic (Black), 4800x1200 optimized dpi (Color)
Power specifications

0957-2286
• Input voltage: 100-240Vac (+/- 10%)
• Input frequency: 50/60 Hz (+/- 3Hz)

0957-2290
• Input voltage: 200-240Vac (+/- 10%)
• Input frequency: 50/60 Hz (+/- 3Hz)

NOTE: Use only with the power adapter supplied by HP.

Cartridge yield
Visit [www.hp.com/go/learnaboutsupplies](http://www.hp.com/go/learnaboutsupplies) for more information on estimated cartridge yields.

Acoustic information
If you have Internet access, you can get acoustic information from the HP Web site. Go to: [www.hp.com/support](http://www.hp.com/support).

Environmental product stewardship program
Hewlett-Packard is committed to providing quality products in an environmentally sound manner. Design for recycling has been incorporated into this product. The number of materials has been kept to a minimum while ensuring proper functionality and reliability. Dissimilar materials have been designed to separate easily. Fasteners and other connections are easy to locate, access, and remove using common tools. High priority parts have been designed to access quickly for efficient disassembly and repair.

For more information, visit HP’s Commitment to the Environment Web site at: [www.hp.com/hpinfo/globalcitizenship/environment/index.html](http://www.hp.com/hpinfo/globalcitizenship/environment/index.html)

This section contains the following topics:
• Eco-Tips
• Paper use
• Plastics
• Material safety data sheets
• Recycling program
• HP inkjet supplies recycling program
• Power consumption
• Disposal of waste equipment by users in private households in the European Union
• Chemical Substances
• Toxic and hazardous substance table

Eco-Tips
HP is committed to helping customers reduce their environmental footprint. HP has provided the Eco-Tips below to help you focus on ways to assess and reduce the impact of your printing choices. In addition to specific features in this product, please visit the HP Eco Solutions web site for more information on HP’s environmental initiatives.


Your product’s Eco features
• Energy Savings information: To determine the ENERGY STAR® qualification status for this product, see [www.hp.com/go/energystar](http://www.hp.com/go/energystar).
• Recycled Materials: For more information regarding recycling of HP products, please visit: [www.hp.com/hpinfo/globalcitizenship/environment/recycle/](http://www.hp.com/hpinfo/globalcitizenship/environment/recycle/)
Paper use
This product is suited for the use of recycled paper according to DIN 19309 and EN 12281:2002.

Plastics
Plastic parts over 25 grams are marked according to international standards that enhance the ability to identify plastics for recycling purposes at the end of product life.

Material safety data sheets
Material safety data sheets (MSDS) can be obtained from the HP Web site at:
www.hp.com/go/msds

Recycling program
HP offers an increasing number of product return and recycling programs in many countries/regions, and partners with some of the largest electronic recycling centers throughout the world. HP conserves resources by reselling some of its most popular products. For more information regarding recycling of HP products, please visit:
www.hp.com/hpinfo/globalcitizenship/environment/recycle/

HP inkjet supplies recycling program
HP is committed to protecting the environment. The HP Inkjet Supplies Recycling Program is available in many countries/regions, and lets you recycle used print cartridges and ink cartridges free of charge. For more information, go to the following Web site:
www.hp.com/hpinfo/globalcitizenship/environment/recycle/

Power consumption
Hewlett-Packard printing and imaging equipment marked with the ENERGY STAR® logo is qualified to the U.S. Environmental Protection Agency’s ENERGY STAR specifications for imaging equipment. The following mark will appear on ENERGY STAR qualified imaging products:

![ENERGY STAR](image)

Additional ENERGY STAR qualified imaging product model information is listed at: www.hp.com/go/energystar
Disposal of waste equipment by users in private households in the European Union

This symbol on the product or its packaging indicates that this product must not be disposed of with your other household waste. Instead, you have the possibility of handing over your waste equipment free of charge to designated collection points in each State. The Member States have put systems in place to ensure the environmentally sound recovery of waste equipment. By handing over your waste equipment to a designated collection point, you are making a valuable contribution to the conservation of natural resources and to the protection of the environment. If your waste equipment contains electrical or electronic components, please note that separate collection facilities are available for these waste streams. The separate collection and recycling of waste equipment helps to conserve natural resources and to protect human health and the environment. Furthermore, it ensures that the waste equipment is recycled in a manner that protects human health and the environment. For more information about where you can deposit your waste equipment for recycling, please contact your local office or office, your household waste disposal service or the person you purchased the product from.

Technological and Environmental Product Stewardship Program

Environmental product stewardship program

Chemical Substances

HP is committed to providing our customers with information about the chemical substances in our products as needed to comply with legal requirements such as REACH (Regulation EC No 1907/2006).

Toxic and hazardous substance table

<table>
<thead>
<tr>
<th>零件描述</th>
<th>有</th>
<th>无</th>
<th>铅</th>
<th>镍</th>
<th>多氯联苯</th>
<th>多氯联苯酸</th>
</tr>
</thead>
<tbody>
<tr>
<td>外壳用托盘*</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>电线*</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>印刷电路板*</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>打印头*</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>显示器*</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>墨盒打印机墨盒*</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>墨盒*</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>打印品*</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>墨水配件*</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>墨盒*</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>墨水配件*</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>外壳*</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

0: 指此部件的所有同一材质中包含的这种有毒有害物质，含量低于 SJ/T 11363-2006 的限制
X: 指此部件使用的同一材质中至少有一种包含的这种有毒有害物质，含量高于 SJ/T 11363-2006 的限制
注：环保使用期限的参考值取决于产品正常工作的温度和湿度等条件
*以上只适用于使用这些部件的产品

Regulatory notices

The HP All-in-One meets product requirements from regulatory agencies in your country/region. This section contains the following topics:

- Regulatory model identification number
- FCC statement
- Notice to users in Korea
- VCCI (Class B) compliance statement for users in Japan
- Notice to users in Japan about the power cord
- HP Deskjet 1050 All-in-One series declaration of conformity

Regulatory model identification number

For regulatory identification purposes, your product is assigned a Regulatory Model Number. The Regulatory Model Number for your product is VCVRA-1001. This regulatory number should not be confused with the marketing name (HP Deskjet 1050 All-in-One series, etc.) or product numbers (CB730A, etc.).
FCC statement

The United States Federal Communications Commission (in 47 CFR 15.105) has specified that the following notice be brought to the attention of users of this product.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient the receiving antenna.
- Increase the separation between the equipment and the receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

For further information, contact:
Manager of Corporate Product Regulations
Hewlett-Packard Company
3000 Hanover Street
Palo Alto, Ca 94304
(650) 857-1501

Modifications (part 15.21)

The FCC requires the user to be notified that any changes or modifications made to this device that are not expressly approved by HP may void the user’s authority to operate the equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Notice to users in Korea

B 급 기기(가정용 방송통신기기)
이 기기는 가정용(B급)으로 전자파적합등록을 한 기기로서 주 로 가정에서 사용하는 것을 목적으로 하며, 모든 지역에서 사용할 수 있습니다.

VCCI (Class B) compliance statement for users in Japan

この装置は、クラスB情報技術装置です。この装置は、家庭環境で使用することを目的としていますが、この装置がラジオやテレビジョン受信機に近接して使用されると、受信障害を引き起こすことがあります。取扱説明書に従って正しい取り扱いをして下さい。

VCCI-B
Notice to users in Japan about the power cord

製品には、同梱された電源コードをお使い下さい。
同梱された電源コードは、他の製品では使用出来ません。

HP Deskjet 1050 All-in-One series declaration of conformity

DECLARATION OF CONFORMITY
according to ISO/IEC 17050-1 and EN 17050-1

DoC #: VCVRA-1001-01

Supplier's Name: Hewlett-Packard Company
Supplier's Address: 60 Alexandra Terrace, #07-01 The Comtech, Singapore 118502

declares, that the product
Product Name and Model: HP Deskjet 2050 All-in-One Series
HP Deskjet 1050 All-in-One Series
Regulatory Model Number: 1) VCVRA-1001
Product Options: All
Power Adapter: 0957-2286
0957-2290 (China and India only)

conforms to the following Product Specifications and Regulations:

EMC: Class B
CISPR 22:2005
EN 61000-3-2:2006
FCC CFR 47 Part 15

Safety:
IEC 60950-1:2005
EN 60950-1:2006

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

The product herewith complies with the requirements of the Low Voltage Directive 2006/95/EC, the EMC Directive 2004/108/EC and carries the CE marking accordingly.

Additional Information:
1) This product is assigned a Regulatory Model Number which stays with the regulatory aspects of the design. The Regulatory Model Number is the main product identifier in the regulatory documentation and test reports, this number should not be confused with the marketing name or the product numbers.

Local contact for regulatory topics only:
EMEA: Hewlett-Packard GmbH, HQ-TRE, Herrenberger Strasse 140, 71034 Boeblingen, Germany

www.hp.com/go/certificates
Index

A
after the support period 42

C
copy
  specifications 44
customer support
  warranty 42

E
environment
  Environmental product
    stewardship program 45
  environmental
    specifications 43

P
paper
  recommended types 15
phone support 41
phone support period
  period for support 41
print
  specifications 44

R.recycle
  ink cartridges 46
regulatory notices
  regulatory model
    identification number 48

S.scan
  scan specifications 44
support process 41
system requirements 43

T.technical information
  copy specifications 44
  environmental
    specifications 43
  print specifications 44

W.warranty 42